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It is suggested that you use Internet Explorer or Mozilla Firefox to view LiveBinders.
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Create a LiveBinders account

[ LiveBinders” i
- .
8 The knowledge sharing place
‘About Binders Featured Binders Leam More Sign Up Tools

Access LiveBinders by going to www.livebinders.com. Select "Sign Up" in

the upper right corner. Enter your user name, email, and password.

LiveBinders are free! Alteady have an account?
Log In here.
Please fill out the following to start making LiveBinders today:

User Name: Letters and numbers only please.
Emall Address:
‘Your email is requested o that we can send you your password in case you forget it

Password: 632 characters
Strength:
() 1 wouldlike to know when you are changing things at LiveBinders.
() | would Ik to rocsive updates abaut how my binders ars viewed or commented on

By clicking on "Sign Up” you agres 1o the terms of use and privacy policy
* Please do not enter personal email addresses for chidren under 13 as we are not alowed to collect this data. Please use school generated or teacher generated emall addresses,

[ sign up |
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DCS Curriculum LiveBinders

Sign Up | Log In | Help

—b |.IVE Blndel‘s ! Search for: | dunin in: [ Shelves + | [ search |
. .
] The knowledge sharing place
About Binders Featured Binders Leam More Sign Up Tools

You can locate the DCS curriculum binders by keying "duplin” in the search text box and
selecting shelves from the drop down arrow in the top right corner. After you locate the
shelf, you can add the binder to your LiveBinders account or a shelf on your account.
When you locate the shelf for your subject/grade level click on "Go to Full Shelf" to view
the entire shelf.

T BB @

Goto Full
Shelf

to see all
& binders

Fourth Sclence_Grade_ SEA ELA Fourth
4th Grade Grade_Pacing/Se 4 Grade

i
Duplin County Schools quen=ng

Author: descurriculum . 1
Views: 104
Binders: & q £

SEA Math Fourth S5 _Grade 4 Health_Grade_4
Grade

AL
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Education

A

. .
Sclence_Grade_B - o ——
Science Grade 8 .
# I

By: Duplin County Schools

When you place your cursor over a binder cover

"Options" should be visible. Select the "Options" drop | view your sheif

" " : (») Private - Only you, and
down menu and choose "Add to Shelf." A binder can | . reooie you choose, can
be added to an "existing shelf" or a "new shelf." view your sheff
When adding to an existing shelf, select the shelf Q‘::é‘;f&’&;?‘:&‘?i; key
from the drop down menu. When adding to a new privale shelf:

shelf, key in the name, description, tags, public/
private Shelf ~ Create New Shelf ’

Adding a binder to your shelf

"Existing Shelf" "New Shelf"
Add to Your LiveBinders Add to Your LiveBinders
Shelf Shelf

(] Views: 50 Add "Science_Grade_8" to Add "Science Grade 8" to

shelf: shelf:
Share this LiveBinder iiechnology Technology
Show Details Add fudd
Link or Embed Or add to new shelf. Or add to new shelf.
Add to Shelf

ame:
Description:

Tags (comma separated):

(_) Public - Everyone can
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Education

Sclence_Grade_B
Science Grade B

Viewing a binder

Click on the cover of the binder to open the binder.

By: Duplin County Schools

Select the tab that you would like to view inside the binder.

{AD LiveBinders - Your 3-ring binder for the web Backtosite | Share v | Add v | 17 | Sign Up | Login

Science_Grade_4 Useful 0
Binder Auhor: Duplin County Schools | Details | Comments 0

mm

htip: Jivebing DE3MQ==
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Printing and saving
binder contents

153y I L AL,

inty Schools Achievement Coach

Print and save options will vary depending on the browser you are
using. Internet Explorer - The print and save icon is located in the
upper left corner of the binder. Firefox - Move your cursor over the
bottom center of the page. The print and save icon should be in that
area.
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Commenting on a binder

Science_Grade_4 Q Uset = O
Binder Author: Duplin County Schools | Det
[ ome - EEREEAESAEEARZALEA

hitto:/Awww.livebinders com/medialgetMikyODE3MQ==

Duplin County Schools commend the teachers and instructional technology staff
that contributed to the development of the first-ever Essential Standards
curriculum guides. These guides are living, breathing documents that will be
revised at least two times per year. The quality of these guides will continue to
improve as you contribute feedback and suggestions while utilizing the guides.
Please note the procedures below for contributing suggestions for
improvement:

J—

1. Inthe top left corner of binder, click the Comments link.
2. Key the Clarifying Objective number in the Title text box.
3. Key yoursuggestion in the Comment text box and click Submit.

You MUST create an account to make comments. Google Chrome and Internet
Explorer are the preferred browsers for using LiveBinders.

For more information or questions, please contact:
Selina Riley Dy
urga

Coach
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Dashboard Menu
Dashboard A

lr‘. Start a Blank Binder

6l start a Blank Shelf
The dashboard allows you to start a

o My Uploadad Files blank binder or shelf. You can also view
the binders and shelves already in your
il Binder Stats account.

’ View Comments

E Bookmark Tool

All My Binders v

My Shelves v
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Select "Start a Blank Shelf" from the dashboard.

10

Start a New Shelf

Wi’ Start a Blank Sher

Create a LiveBinders Shelf

Name:
Description:
Key in the relevant information for
Tags (comma separated): the boxes provided. You can make
the shelf public or private and
) Public - Everyone can assign an access key to be able to
view your shelf .
(%) Private - Only you, and prote_ct the private shelf. After
the people you choose, can creating a new shelf you can add
view your shelf q
any of your personal binders to the
Access Key - give this key shelf or other binders that you find
to people when sharing this . .
private shelf: on LiveBinders.

Create Mew Shelf
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Start a New Bind

er

I"- Start a Blank Binder

Select "Start a Blank Binder" from the dashboard.

Create New Binder

Please name your binder here:

Description:

Tags (comma separated):
Category: | Personal al

() Public - Everyone can view your binder
(%) Private - Only you, and the people you choose, can view your binder

Access Kg! - give this ke! to geog\e when sharing this grivate binder:

Use Google search to fill a binder () Yes () No
* required

| Create New Binder |

11

Key in the required information for
your new binder. You can make the
binder public or private and assign
an access key to protect private
binders.
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Editing your binder

A LiveBimdirs ¥ The Knuwhedge Sharing Pioce

Recipes

Binder Author: LivaBingers | Updated: 12-31-10 | Datals

- —— ——

Click on this button to
bring up the Edit Menu

e 1

-
Frtar o 1R T

7

Edit Menu™ Upload Fae | Tats | Insert Media | Text Layout | Bider Properties

Tiea Fincpes Ta charne e Lot it
et 3 18 then chck Change

Dascrption: | Rocpes

= Thumtrad Wote: Thatnads

Taga Rocpes e oated magen emeg

Category Pesianal 2] e, phaasa b Pl g
Tosart Mk ssove fr ncm

Acoas B

Ky

Comments 0 | Gopy

share 5]l @ 12 @K B

20 LiveBinders ™ s Keansdge Sharmg Phcs

Reci|
Binder Author. LiveBinders.

) Add Hew Tab
X Delete This Tab
# Move Tab Len
\* Mave Tab Right
) e i Sutesn
"Dpen Advanced Tab Menu
(Cow )

Enter a URL:

Click on this
arrow to add,
delete, and
move tabs
and subtabs

Comments 0 | Cogy

12

« Back o My Binders | Welcoms LiveBindees | Log et | Help
Sove | Quich Guide | Ethiens

—

Save | Clear | Unda | Close Edit Maru B

e * |

< Back 10 my Binsers | waicoms Lvegingars | Log Out | Hep

Savm | Cuick Guide  Edit Men

Tt ) (Hew Tob ) (Mew Subsab ) ((GoteSie )

srare o @ 12 QK 0o Prosent u’
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Uploading a file to your binder

& Edit Menu Tabs | Insert Media | Text layout | Properties

v : " aon B0 2 Browse to
< 1. Click on "Upload File ]
3 P A% the File

F E——

| Browse... ) ==
e Vs ~ 7 Y
kUpIDacIJ L Upload to New Tab 9 ¢ Upload to New Subtab

3. Click on "Upload"
o/
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Creating a LiveBinder with Google Search

Dashboard

|i Start a Blank Binder

W Starta Blenk Sher

© v Upioaces Fies

ull  Biner stas

 view Comments

B Bookmark Tool

All My Binders

My Shelves

John F. Kennedy
Binder Author: linjayiee | Details | Comments 0

ST TRI NIl John F - Kennedy - Wikipedia, the free enc | John F . Kennedy | The White House | JFK - John F . Kennedy Intemational Airpa | John F . Kennedy : Biography

A

Create New Binder

You can create a

Please name your binder here:

John F. Kennedy " LiveBinder on a
Description: " Selected tOpIC by
Tags (comma separated): : automatically filling it

with Google search

Category: | Education

results. Key in the
- () Public - Everyone can view your binder X
(=) Private - Only you, and the people you choose, can view your binder b|nde|‘ name’
M Access Key - give this key to peaple when sharing this private binder: descri ption Category

Use Google search to fill a binder () Yes () No

select yes and key in a

search term.

To automatically fill a binder - enter a Google search term here:
Jahn F. Kennedy

* required

Create New Binder
Save | QuickGuide  Edit Menu

John F . Kennedy Biography - Facts, Quot | American President: John Fitzgerald Kenni | John F . Kennedy University

Enter a URL: [hitpiwww fkibrary.orgl insert | [ Gotosite

14

PRES

HOME

JOHN E KENNEDY EETTTT—

News and Press | Donate Now | Hostan Event | Online Museum Store

IDENTIAL LIBRARY AND MUSEUM Advar

JFK VISIT EXHIBITS RESEARCH EDUCATION NTS & AWARDS  ABOUT US

Example of
binder created
using Google
search. You can
delete
unwanted tabs
from the binder.
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LiveBinder It

What is LiveBinder It?

f LiveBinders - Bookmark to a Binder - Window:

——

-

S A £ | http:ffwww livebinders,com/

File Edit View Favorites Tools Help
i Links @] LiveBinder It

“LiveBinder It" is a bookmarking tool that you can add to your browser tool bar. While you are browsing the web, you
can add web pages directly into one of your binders or a new binder in your account by clicking on the LiveBinder It
link. This way, you can add pages without having to go to the LiveBinders site. It is a quicker and easier way to add

web pages to your binders.

15
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LiveBinder It on Internet Explorer

How do | add the LiveBinder Bookmarklet on IE?

Right-click on this button: '[T@Li\reBinder It and then select "Add to Favorites”. Click "Yes" in the "Security
Alert" box. Then under "Create in" choose the "links" folder (for IET) or the "Faveorites Bar" (for IEB & IE9).

If you don't see "LiveBinder It" in your toolbar (like below image), make sure you select "View >> toolbars >> links"
from the "View" menu or click on the ">>" icon on the right side of your toolbar and you should see it listed. (For IET &

IEB).

({ LiveBinders - Bookmark to a Binder - Window:

|§, http:/fwww.livebinders.com/

e
- -

File Edit View Favorites Tools Help
i Links g | LiveBinder It

For IE9, right click on the area to the right of the tabs at the top and check "Favorites Bar".

(=N | B =5

* B0 X||® organi i A
P~2 Organize your resources in ... e bh}

v Favorites bar

Command bar
Status bar

Browsing Protection Toolbar

16
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LiveBinder It on Firefox

How do | add the LiveBinder it Bookmarklet on Firefox?

Simply drag this button: '[—ibli\reﬂinder “}up to your toolbar. That's it!

If you don't see "LiveBinder It" in your teolbar (like image below), make sure you select "View >> toolbars >>
bookmarks toclbar" from the "View" menu and you should see it.

) LiveBinders - Bookmark to a Binder - Mozilla Firefox

File Edit View Higtory delicdo.us Bookmarks Tools Help

- - @ ﬁ_l‘ E TAG |g.. http: /fwww livebinders.com/

[ LiveBinder It

View this video on adding bookmarklet in Firefox:

Aug 17-4:01 PM

LiveBinder It on Safari

How do | add the LiveBinder it Bookmarklet on Safari?

Simply drag this button: 'mL‘I‘U‘BBdeT “}up to your toolbar. That's it!

If you don't see "LiveBinder It" in your toolbar (like image below), make sure you select "View => show bookmarks
bar" from the "View" menu and you should see it.

LiveBinder It

View this video on adding the LiveBinder it bookmarklet in Safari:

Aug 17-4:01 PM




LiveBinder It on Chrome

How do | add the LiveBinder it Bookmarklet on Chrome?

1. Check that you have "Always show bookmarks tool bar" checked in your browser settings.

2. Then simply drag this link: LiveBinder It up to your bookmarks bar. That's it!

19
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LiveBinder It on an iPad

How do | add the LiveBinder it Bookmarklet on an iPad?

There are two ways to add "LiveBinder It" to the iPad. One is to add it on to Safari on your Mac and then sync your bookmarks with the iPad. Here is an explanation of
how to syne your bookmarks from your Mac to your iPad.

The second option isn't easy, but it will add the LiveBinder It feature to your iPad. Hopefully Apple will soon come cut with a better way to add bookmarklets!

< Lo rt

Add Bookmark
Add to Reading List [
Add to Home Screen

Mail Link to this Page

Tweet
g border lines in Word

. In Safari, click en the square with the arrow icon at the top of your browser
. Click on the "Add Bookmark"

For the name, type in "Livebinder It*

. Click on "Save"

Click on the bockmark icon

Click on "Edit" in the top right comer of the bookmarks menu

. Click on the "LiveBinder It" bookmark

Under "LiveBinder It", cut and past the following:

DNomALP

javascript:var¥%20w% 20="%20window.open('http://www.livebinders.com/media/add_url?
url="+encodeURIComponent{location. href)+'&descriptior encodeURICompenent{document.title), LiveBinders',%20'scroll
bars=0,status=0,resizable=1,location=0,toolbar=0,width=850, height=700"); (function{}setTimeout('w.focus (), 1000} })();

el

9. Click on "Done" on the keyboard.

20
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Additional "help" information and
tutorials are available at

http://www .livebinders.com/help
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Attachments

J http://www.livebinders.com/help
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